Dynamic Barcodes for Adobe Illustrator 16.1

User Guide
Contents

1. Copyright Notice........................................................................................................................................... 5
   1.1 Third party license information........................................................................................................... 6

2. What is a barcode ?........................................................................................................................................ 17

3. Getting Started with Dynamic Barcodes.................................................................................................. 18

4. Using Dynamic Barcodes in Unlicensed Mode......................................................................................... 20

5. Dynamic Barcodes Basics.......................................................................................................................... 21
   5.1 Creating a Barcode............................................................................................................................... 21
   5.2 Editing a Barcode.................................................................................................................................. 24
   5.3 Setting Barcode Parameters to Default.............................................................................................. 24
   5.4 Barcode Placeholders........................................................................................................................... 25
      5.4.1 Creating a Barcode Placeholder Quickly.................................................................................. 25
      5.4.2 Previewing and Creating a Barcode Placeholder....................................................................... 27

6. Dynamic Barcodes Advanced.................................................................................................................... 30
   6.1 Choosing a Font Standard.................................................................................................................... 30
   6.2 Using Dynamic Content with Dynamic Barcodes.............................................................................. 30
   6.3 Barcode Protection................................................................................................................................ 31
      6.3.1 Protecting a Barcode................................................................................................................... 31
      6.3.2 Handling a Barcode without Dynamic Barcodes....................................................................... 31
   6.4 Exporting Documents with Barcodes.................................................................................................. 33
      6.4.1 Viewing Barcode Information in Other Esko Applications......................................................... 33
      6.4.2 Editing Barcodes in Other Esko Applications............................................................................ 34

7. Barcode Types and Parameters................................................................................................................... 35
   7.1 Supported Barcode Types..................................................................................................................... 35
      7.1.1 GS1 Application Identifiers........................................................................................................... 37
   7.2 Barcode Types....................................................................................................................................... 42
      7.2.1 2 of 5.............................................................................................................................................. 42
      7.2.2 CLF-8............................................................................................................................................ 43
      7.2.3 Codabar......................................................................................................................................... 44
      7.2.4 Code 128....................................................................................................................................... 44
      7.2.5 Code 128 (long)............................................................................................................................ 45
      7.2.6 Code 39......................................................................................................................................... 46
      7.2.7 DataMatrix..................................................................................................................................... 47
      7.2.8 EAN 8.......................................................................................................................................... 47
      7.2.9 EAN 13......................................................................................................................................... 48
      7.2.10 EAN 13 Swissmedic.................................................................................................................. 49
      7.2.11 GS1 128...................................................................................................................................... 51
7.3 Barcode Parameters

7.3.1 Rotation...........................................................................................................................81
7.3.2 Code.................................................................................................................................81
7.3.3 Composite Component....................................................................................................82
7.3.4 Add Human Readable Characters..................................................................................82
7.3.5 Put on Top........................................................................................................................83
7.3.6 Multiple Text Lines.........................................................................................................83
7.3.7 Light Margin Indicator....................................................................................................83
7.3.8 Font Family, Style and Size.............................................................................................84
7.3.9 Alignment.........................................................................................................................84
7.3.10 Vertical Offset................................................................................................................84
7.3.11 Use “992” Prod. Family in UPC..................................................................................85

7.2.12 GS1 DataBar Omnidirectional.......................................................................................52
7.2.13 GS1 DataBar Stacked......................................................................................................53
7.2.14 GS1 DataBar Stacked Omnidirectional.........................................................................54
7.2.15 GS1 DataBar Truncated..................................................................................................54
7.2.16 GS1 DataBar Expanded..................................................................................................55
7.2.17 GS1 DataBar Expanded Stacked....................................................................................56
7.2.18 GS1 DataBar Limited......................................................................................................57
7.2.19 GS1 DataMatrix..............................................................................................................58
7.2.20 GS1 QR..........................................................................................................................59
7.2.21 GS1 U.S. Coupon Interim...............................................................................................60
7.2.22 HIBC 128......................................................................................................................61
7.2.23 HIBC 39........................................................................................................................62
7.2.24 ITF-14.............................................................................................................................62
7.2.25 ITF-16.............................................................................................................................63
7.2.26 Interleaved 2 of 5..........................................................................................................64
7.2.27 Laetus Pharma Code......................................................................................................65
7.2.28 M+S 7............................................................................................................................66
7.2.29 MSI.................................................................................................................................67
7.2.30 Marks & Spencer’s........................................................................................................68
7.2.31 NDC / HRI......................................................................................................................68
7.2.32 Paraf Italy.......................................................................................................................69
7.2.33 PDF417...........................................................................................................................70
7.2.34 MicroPDF417................................................................................................................72
7.2.35 PZN.................................................................................................................................73
7.2.36 PZN8................................................................................................................................74
7.2.37 QR...................................................................................................................................74
7.2.38 MicroQR........................................................................................................................76
7.2.39 SICK Code.....................................................................................................................77
7.2.40 UPC-A............................................................................................................................78
7.2.41 UPC-E............................................................................................................................79
7.2.42 UPC-SCS.......................................................................................................................80

7.3 Barcode Parameters...........................................................................................................81
7.3.12 Max. Row Width.........................................................85
7.3.13 Text Format.................................................................85
7.3.14 Bar Width Reduction..................................................85
7.3.15 Device Compensation................................................86
7.3.16 Magnification.............................................................86
7.3.17 Size...........................................................................86
7.3.18 Height.......................................................................86
7.3.19 Characters per unit....................................................87
7.3.20 Ratio.........................................................................89
7.3.21 Narrow Bar...............................................................89
7.3.22 Wide Bar.................................................................89
7.3.23 Gap............................................................................89
7.3.24 Vertical alignment......................................................89
7.3.25 Snap Bars to Output Resolution.................................90
7.3.26 Decimal Input............................................................90
7.3.27 Add Check Digit.........................................................90
7.3.28 Symbol Type.............................................................91
7.3.29 Cell Size....................................................................91
7.3.30 Width / Total Height..................................................91
7.3.31 Total Height...............................................................92
7.3.32 Smax / Smin...............................................................92
7.3.33 Box..........................................................................93

8. Barcode Parameters from the Job Folder.................................95
   8.1 Connecting to a Job Folder.............................................95
   8.2 Connect Dynamic Barcodes to Job Setup........................96
   8.3 Use Barcode parameters from Job Setup.........................96
   8.4 Updating barcode parameters from Job Setup................98
1. Copyright Notice

© Copyright 2018 Esko Software BVBA, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the property of Esko Software BVBA. The material, information and instructions are provided on an AS IS basis without warranty of any kind. There are no warranties granted or extended by this document. Furthermore Esko Software BVBA does not warrant, guarantee or make any representations regarding the use, or the results of the use of the software or the information contained herein. Esko Software BVBA shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means without prior written permission from Esko Software BVBA.

This document supersedes all previous dated versions.

PANTONE®, PantoneLIVE and other Pantone trademarks are the property of Pantone LLC. All other trademarks or registered trademarks are the property of their respective owners. Pantone is a wholly owned subsidiary of X-Rite, Incorporated. © Pantone LLC, 2015. All rights reserved.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF, Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.
1.1 Third party license information

This product includes Botan.

Copyright (C) 1999–2009 Jack Lloyd
2001 Peter J Jones
2004–2007 Justin Karneges
2005 Matthew Gregan
2005–2006 Matt Johnston
2006 Luca Piccarreta
2007 Yves Jerschow
2007–2008 FlexSecure GmbH
2007–2008 Technische Universitat Darmstadt
2007–2008 Falko Strenzke
2007–2008 Martin Doering
2007 Manuel Hartl
2007 Christoph Ludwig
2007 Patrick Sona
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions, and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR(S) "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR(S) OR CONTRIBUTOR(S) BE
This product includes ICC Profiles.

Some ICC Profiles were created by FFEI Ltd. (www.ffei.co.uk) using Fujifilm ColourKit Profiler Suite (www.colourprofiling.com)

This product includes ICC Profiles.

Some ICC profiles are copyright (C) by European Color Initiative, www.eci.org

This product includes ICC Profiles.

Some ICC profiles are copyright (C) of WAN-IFRA, www.wan-ifra.org

This product includes ICC Profiles.

Some ICC profiles are copyright (C) IDEAlliance(R). G7(R), GRACol(R) and SWOP(R) are all registered trademarks of IDEAlliance(C).

This product includes curl.

Copyright (c) 1996 - 2015, Daniel Stenberg, <daniel@haxx.se>.
All rights reserved.

Permission to use, copy, modify, and distribute this software for any purpose with or without fee is hereby granted, provided that the above copyright notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used in advertising or otherwise to promote the sale, use or other dealings in this Software without prior written authorization of the copyright holder.

This product includes LibTIFF.

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR
ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

This product includes FCollada.

Copyright 2006 Feeling Software. All rights reserved.
Copyright (C) 1998-2003 Daniel Veillard. All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

This product includes FreeType.

Portions of this software are copyright (C) 2014 The FreeType Project (www.freetype.org) licensed under the Freetype License.
All rights reserved.

This product includes gSOAP.

EXHIBIT B.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are Copyright (C) 2001-2007 Robert A. van Engelen, Genivia inc. All Rights Reserved.

THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GENIVIA INC AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes ICU.

Copyright (c) 1995-2014 International Business Machines Corporation and others All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, provided that the above copyright notice(s) and this permission notice appear in all copies of the Software and that both the above copyright notice(s) and this permission notice
Dynamic Barcodes for Adobe Illustrator

appear in supporting documentation.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

------------------------------------------------------------

This product includes ilmbase.

Copyright (c) 2006, Industrial Light & Magic, a division of Lucasfilm Entertainment Company Ltd. Portions contributed and copyright held by others as indicated. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Industrial Light & Magic nor the names of any other contributors to this software may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------

This product includes iODBC.

Copyright (C) 1995-2006, OpenLink Software Inc and Ke Jin. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
3. Neither the name of OpenLink Software Inc. nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL OPENLINK OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
This product includes IP*Works!.

Copyright (c) 2013 /n software inc. - All rights reserved.

DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED BY YOU. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. FURTHER, THE LICENSED SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR INTENDED FOR USE OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE FAILURE OF THE LICENSED SOFTWARE COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS SUPPLIERS SPECIFICALLY DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH RISK ACTIVITIES.

LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE LIABILITY OF /N SOFTWARE, IF ANY, FOR DAMAGES RELATING TO THE LICENSED SOFTWARE SHALL BE LIMITED TO THE ACTUAL AMOUNTS PAID BY YOU FOR SUCH LICENSED SOFTWARE. /N SOFTWARE'S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO LIABILITY TO YOU FOR ANY DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF USING THE LICENSED SOFTWARE, OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING, IN NO EVENT SHALL /N SOFTWARE, ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION, ANY COMMERCIAL DAMAGES OR LOSSES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OR INABILITY TO USE THE LICENSED SOFTWARE, OR ANY PORTION THEREOF, EVEN IF /N SOFTWARE, ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE SUPPLIERS HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT ALLOW THE EXCLUSION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY. EACH EXCLUSION OF LIMITATION IS INTENDED TO BE SEPARATE AND THEREFORE SEVERABLE.

This product includes IP*Works! SSH.

Copyright (c) 2013 /n software inc. - All rights reserved.

DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED BY YOU. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. FURTHER, THE LICENSED SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR INTENDED FOR USE OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE FAILURE OF THE LICENSED SOFTWARE COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS SUPPLIERS SPECIFICALLY DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH RISK ACTIVITIES.

LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE LIABILITY OF /N SOFTWARE, IF ANY, FOR DAMAGES RELATING TO THE LICENSED SOFTWARE SHALL BE LIMITED TO THE ACTUAL AMOUNTS PAID BY YOU FOR SUCH LICENSED SOFTWARE. /N SOFTWARE'S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO LIABILITY TO YOU FOR ANY DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF USING THE LICENSED SOFTWARE, OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING, IN NO EVENT SHALL /N SOFTWARE,
ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL, CONSEQUENTIAL DAMAGES OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION, ANY COMMERCIAL DAMAGES OR LOSSES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OR INABILITY TO USE THE LICENSED SOFTWARE, OR ANY PORTION THEREOF, EVEN IF /N SOFTWARE, ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE SUPPLIERS HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT ALLOW THE EXCLUSION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY. EACH EXCLUSION OR LIMITATION IS INTENDED TO BE SEPARATE AND THEREFORE SEVERABLE.

This product includes IP*Works! SSL.
Copyright (c) 2013 /n software inc. - All rights reserved.

DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED BY YOU. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. FURTHER, THE LICENSED SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR INTENDED FOR USE OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE FAILURE OF THE LICENSED SOFTWARE COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS SUPPLIERS SPECIFICALLY DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH RISK ACTIVITIES.

LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE LIABILITY OF /N SOFTWARE SHALL BE LIMITED TO THE ACTUAL AMOUNTS PAID BY YOU FOR SUCH LICENSED SOFTWARE. /N SOFTWARE'S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO LIABILITY TO YOU FOR ANY DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF USING THE LICENSED SOFTWARE, OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING, IN NO EVENT SHALL /N SOFTWARE, ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION, ANY COMMERCIAL DAMAGES OR LOSSES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OR INABILITY TO USE THE LICENSED SOFTWARE, OR ANY PORTION THEREOF, EVEN IF /N SOFTWARE, ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE SUPPLIERS HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT ALLOW THE EXCLUSION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY. EACH EXCLUSION OR LIMITATION IS INTENDED TO BE SEPARATE AND THEREFORE SEVERABLE.

This product includes JBIG2Lib.
Portions of this product copyrights (C) 2002 Glyph & Cog, LLC.

This product includes JPEGLib.
This software is copyright (C) 1991-2016, Thomas G. Lane, Guido Vollbeding.
All Rights Reserved.
This software is based in part on the work of the Independent JPEG Group.

This product includes Little CMS.
Little CMS
Copyright (c) 1998-2011 Marti Maria Saguer
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
Dynamic Barcodes for Adobe Illustrator

copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

The SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

This product includes leptonica.

Copyright (C) 2001-2016 Leptonica. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL ANY CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes libpng.

Copyright (c) 2000-2002 Glenn Randers-Pehrson

The PNG Reference Library is supplied "AS IS". The Contributing Authors and Group 42, Inc. disclaim all warranties, expressed or implied, including, without limitation, the warranties of merchantability and of fitness for any purpose. The Contributing Authors and Group 42, Inc. assume no liability for direct, indirect, incidental, special, exemplary, or consequential damages (including, but not limited to, procurement of substitute goods or services; loss of use, data, or profits; or business interruption) however caused and on any theory of liability, whether in contract, strict liability, or tort (including negligence or otherwise) arising in any way out of the use of this software, even if advised of the possibility of such damage.

This product includes libxml2.

Copyright (C) 1998-2012 Daniel Veillard. All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

This product includes openexr.

Copyright (c) 2006, Industrial Light & Magic, a division of Lucasfilm Entertainment Company Ltd. Portions contributed and copyright held by others as indicated. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of Industrial Light & Magic nor the names of any other contributors to this software may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes OpenJPEG.

Copyright (c) 2002-2012, Communications and Remote Sensing Laboratory, Universite catholique de Louvain (UCL), Belgium
Copyright (c) 2002-2012, Professor Benoit Macq
Copyright (c) 2003-2012, Antonin Descampe
Copyright (c) 2003-2009, Francois-Olivier Deaux
Copyright (c) 2005, Herve Drolon, Freeimage Team
Copyright (c) 2002-2003, Yannick Verschueren
Copyright (c) 2001-2003, David Janssens
Copyright (c) 2011-2012, Centre National d'Etudes Spatiales (CNES), France
Copyright (c) 2012, CS Systemes d'Information, France
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 'AS IS' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes OpenSSL.

Copyright (c) 1998-2011 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following acknowledgment:
   "This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment:
   "This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes OpenSSL.

Copyright (c) 1995-1998 Eric Young (eay@cryptsoft.com)

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following acknowledgment:
   "This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)"

The word 'cryptographic' can be left out if the routines from the library
Dynamic Barcodes for Adobe Illustrator

being used are not cryptographic related :-).  

4. If you include any Windows specific code (or a derivative thereof) from  
the apps directory (application code) you must include an acknowledgement:  
"This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG `AS IS' AND  
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE  
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE  
ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE  
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL  
 DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS  
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)  
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT  
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY  
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF  
SUCH DAMAGE.

------------------------------------------------------------
This product and use of this product is under license from Markzware  
under U.S. Patent No. 5,963,641.
------------------------------------------------------------
This product includes Qt.  
The Qt Toolkit is Copyright (C) 2015 Digia Plc and/or its subsidiary(-ies).  
------------------------------------------------------------
This product includes Qt.  
The Qt Toolkit is Copyright (C) 2014 Digia Plc and/or its subsidiary(-ies).  
------------------------------------------------------------
This product includes QtMigration.  
Copyright (C) 2013 Digia Plc and/or its subsidiary(-ies).  
Redistribution and use in source and binary forms, with or without  
modification, are permitted provided that the following conditions are  
met:  
* Redistributions of source code must retain the above copyright  
notice, this list of conditions and the following disclaimer.  
* Redistributions in binary form must reproduce the above copyright  
notice, this list of conditions and the following disclaimer in  
the documentation and/or other materials provided with the  
distribution.  
* Neither the name of Digia Plc and its Subsidiary(-ies) nor the names  
of its contributors may be used to endorse or promote products derived  
from this software without specific prior written permission.  

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS  
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT  
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR  
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT  
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,  
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT  
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,  
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY  
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT  
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE  
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE."

------------------------------------------------------------
This product includes tesseract.  
Copyright (C) 2016 Google, Inc. Licensed under the Apache License, Version 2.0  
------------------------------------------------------------
This product includes LibTIFF.  
Copyright (c) 1988-1997 Sam Leffler  
Copyright (c) 1991-1997 Silicon Graphics, Inc.
Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

-------------------------------------------------------------------
This product includes XercesC.

NOTICE file corresponding to section 4(d) of the Apache License, Version 2.0, in this case for the Apache Xerces distribution.

This product includes software developed by
The Apache Software Foundation (http://www.apache.org/).

Portions of this software were originally based on the following:

-------------------------------------------------------------------
This product includes XMP Toolkit.

Copyright (c) 1999 - 2010, Adobe Systems Incorporated
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of Adobe Systems Incorporated, nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

-------------------------------------------------------------------
This product includes zlib.

Copyright (C) 1995-2004 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied warranty. In no event will the authors be held liable for any damages arising from the use of this software.
2. What is a barcode?

A barcode is a machine-readable representation of information in a visual format on a surface. Barcodes can be read by optical scanners, allowing quick and easy identification of all kind of goods.

Originally barcodes stored data in the widths and spacings of printed parallel lines, but today they also come in patterns of dots, concentric circles, and hidden in images.

The information contained in a barcode varies from numbers to complete ASCII texts. The drive to encode ever more information in combination with the space requirements of simple barcodes led to the development of matrix barcodes or 2D barcode, which do not consist of bars but rather a grid of square cells.

Barcodes are just the visible part of often quite large systems frequently referred to as automated identification systems. These systems are increasingly proving to be some of the most cost-effective management tools, since they enable organizations to keep track of their goods and stocks in all kinds of situations in a fast, accurate and efficient way.

With the Dynamic Barcodes plug-in, you can add a dynamic barcode to your document without leaving your application. Dynamic means that your barcode settings can be changed later on, even after you saved, closed and reopened your document.
3. Getting Started with Dynamic Barcodes

To introduce you to Dynamic Barcodes, here is how to make your first barcode in four simple steps.

1. Create a CMYK Illustrator document and go to **Windows > Esko > Dynamic Barcodes**. This opens the **Dynamic Barcodes** dialog.

2. Define the color of the barcode: in your Illustrator color palette, define a single-color fill style and no stroke.

3. Enter the barcode parameters (**Barcode Type**, numeric **Code**) in the **Dynamic Barcodes** dialog.

   For example, for an EAN 13 barcode, select **EAN 13** as **Barcode Type** and enter a 13 digit **Code**.
Dynamic Barcodes for Adobe Illustrator

4. Click the Create button and Dynamic Barcodes will generate the barcode in your document.
4. Using Dynamic Barcodes in Unlicensed Mode

If you don’t have a license for the Dynamic Barcodes plug-in, you still use it in unlicensed mode to perform limited operations. You can:

• Open documents containing barcodes created by Dynamic Barcodes without warning messages.

• Create barcode placeholders (with no data in them) in your design.
  See *Creating a Barcode Placeholder Quickly* on page 25.

You can also use the regular Illustrator functions to:

• change the barcode's position in your document,

• rotate it by multiples of 90 degrees (using **Object > Transform > Rotate**),

**Tip:** You can rotate several barcodes at once.

• change its fill color (it is not possible to apply a stroke),

**Attention:**
Choose a fill color that is:

• a process or a spot color (other colors might generate trapping problems),

• not too light (or the barcode might be difficult to scan).

• copy and paste it.

• delete it.
Dynamic Barcodes for Adobe Illustrator

5. Dynamic Barcodes Basics

5.1 Creating a Barcode

1. Create a CMYK Illustrator document and go to **Windows > Esko > Dynamic Barcodes**.
   You can also use the **Command + Option + 4** shortcut on Mac, or the **CTRL + Alt + 4** shortcut on PC.
   This opens the **Dynamic Barcodes** dialog.

![Dynamic Barcodes dialog](image)

2. Define the color of the barcode: in your Illustrator color palette, define a single-color fill style and no stroke.
   Dynamic Barcodes creates bars by generating rectangular objects and assigning the current fill style to them.

![Color palette](image)
Attention:
Choose a fill color that is:
- a process or a spot color (other colors might generate trapping problems),
- not too light (or the barcode might be difficult to scan).

3. In the Dynamic Barcodes dialog, select your Barcode Type.
4. Enter a Rotation angle for your barcode, or use one of the rotation buttons. Choose the Orientation of your barcode using one of the buttons or by entering an angle.
5. Enter the barcode's data in the Code field. For most barcodes, you can choose to also show this data as a (human-readable) number.

Attention: Make sure the barcode data you enter is valid for the barcode type you chose. If it isn't, a warning / error will pop up.

Note: If you enter a wrong check digit, Dynamic Barcodes can fix it automatically for you.

6. To fill in other parameters specific to the barcode type you chose, open the Additional parameters section and see Barcode Types on page 42.
7. Click the **Create** button.
   - If you have the boostX plug-in installed, Dynamic Barcodes generates your barcode at the intersection of the boostX crosshair.
   - If you don't have the boostX plug-in installed, Dynamic Barcodes generates your barcode in the center of the view.
5.2 Editing a Barcode

With Dynamic Barcodes, you can also edit existing barcodes.

1. Open the Dynamic Barcodes.
2. Select the barcode to edit in your Illustrator document.
3. Change its parameters as you wish in the Dynamic Barcodes dialog.

**Note:**
If you change the Barcode Type and the previous Code is not valid for this barcode type, Dynamic Barcodes will reset it to the (first) default code for this barcode type.

This is the default code used for placeholder barcodes; you can see it in the preset barcodes dialog (see Previewing and Creating a Barcode Placeholder on page 27).

You can then either:
- enter your own valid code,
- use this default code to create a placeholder barcode (see Creating a Barcode Placeholder Quickly on page 25).

4. Click the Apply button to apply your changes to the barcode.

5.3 Setting Barcode Parameters to Default

- To reset all the parameters of the selected barcode to default, click the palette menu in the top right corner of the Dynamic Barcodes dialog then click Set Default Parameters.
5.4 Barcode Placeholders

If you don't have the exact data to encode in your barcode yet, you can already create a barcode placeholder in your design.

This placeholder will have the correct symbol type for the barcode type you choose, but will only contain “empty” or “default” data (for example 0000000000000 for EAN 13).

5.4.1 Creating a Barcode Placeholder Quickly

1. Open the Dynamic Barcodes dialog from Windows > Esko > Dynamic Barcodes.
2. Define the color of the barcode: in your Illustrator color palette, define a single-color fill style and no stroke.
Dynamic Barcodes for Adobe Illustrator

Attention:
Choose a fill color that is:
- a process or a spot color (other colors might generate trapping problems),
- not too light (or the barcode might be difficult to scan).

3. In the Dynamic Barcodes dialog, select your Barcode Type.
   The Code field is automatically filled out with a null / default value that has the correct number of digits for your Barcode Type (for example 0000000000000 for EAN 13).

4. Click the Create button to create your barcode placeholder.
5.4.2 Previewing and Creating a Barcode Placeholder

You can use Dynamic Barcodes to preview different barcode types before creating your barcode placeholder.

1. Open the **Dynamic Barcodes** dialog from **Window > Esko > Dynamic Barcodes**.
2. Define the color of the barcode: in your Illustrator color palette, define a single-color fill style and no stroke.

![Color Palette](image)

**Attention:**
Choose a fill color that is:

- a process or a spot color (other colors might generate trapping problems),
- not too light (or the barcode might be difficult to scan).

3. In the **Dynamic Barcodes** dialog, click the Pre-set barcodes icon.
This opens the **Select Barcode** dialog.
4. Select your **Barcode Type** on the right to see a **Preview** of it on the left.

**Note**: This shows previews of barcode placeholders. Your actual barcode (with data and specific parameters affecting its size) may look slightly different. For more information on barcode parameters, see **Barcode Types** on page 42.

5. If your barcode data can have several possible lengths (for example EAN 13 can have 13, 15 or 18 digits), choose the length you want to preview in **Code Preset**.

6. If your barcode can have a **Composite Component** (some GS1 barcodes), you can choose to preview it with or without that component.

7. Click **OK** to use the preview parameters (**Barcode Type**, **Code Preset** and **Composite Component** as applicable) in the **Dynamic Barcodes** dialog and close the **Select Barcode** dialog.

8. In the **Dynamic Barcodes** dialog, click the **Create** button to create your barcode placeholder.
Dynamic Barcodes for Adobe Illustrator
6. Dynamic Barcodes Advanced

6.1 Choosing a Font Standard

You can choose between two font standards for the human-readable characters of your barcodes.

1. Go to Illustrator > Preferences > Esko > Dynamic Barcodes Preferences... to open the Dynamic Barcodes Preferences dialog.

2. Choose either OCR-B Standard or OCR-B Bitstream and click OK.

**OCR-B Standard** fonts are rounder and typically used in the Western market.

**OCR-B Bitstream** fonts are typically used in the Asian market.

<table>
<thead>
<tr>
<th>OCR-B Standard fonts are rounder and typically used in the Western market.</th>
<th>1 2345678</th>
</tr>
</thead>
<tbody>
<tr>
<td>OCR-B Bitstream fonts are typically used in the Asian market.</td>
<td>1 234567</td>
</tr>
</tbody>
</table>

**Note:** If the OCR-B Bitstream font is not installed on your system, the option will be disabled. Esko does not provide this font.

6.2 Using Dynamic Content with Dynamic Barcodes

You can use the Dynamic Content plug-in to turn barcodes created with Dynamic Barcodes into XML-driven objects. These barcodes update automatically when the XML files to which they are linked change.
6.3 Barcode Protection

Once you create a barcode with Dynamic Barcodes, this barcode is protected. This means that it won't be possible to edit it with most regular Illustrator tools. This protects the barcode against modifications that might render it invalid, for example distorting it or modifying its size. You can still edit the barcode's parameters at any time through the Dynamic Barcodes dialog.

6.3.1 Protecting a Barcode

You can protect a Dynamic Barcodes barcode that has been unprotected, or a barcode made in a previous version of Dynamic Barcodes.

1. Open the Dynamic Barcodes plug-in.
2. Select the barcode to protect in your Illustrator document.
3. If necessary, change its parameters in the Dynamic Barcodes dialog.
4. Click the Apply button to apply the parameter changes and protect your barcode.

Tip: You can use this to fix some invalid barcodes.

6.3.2 Handling a Barcode without Dynamic Barcodes

Opening a Document Containing a Dynamic Barcodes Barcode without Dynamic Barcodes

When opening a document containing a Dynamic Barcodes barcode in an Illustrator application that doesn't have the Dynamic Barcodes plug-in, you will get the following warning:
This *doesn't create any problem in your file*, and you can continue to work with this file as you normally would, without editing the Dynamic Barcodes barcode.

If you need to edit the Dynamic Barcodes barcode with your Illustrator application, see *Editing a Document Containing a Dynamic Barcodes Barcode without Dynamic Barcodes* on page 32.

**Editing a Document Containing a Dynamic Barcodes Barcode without Dynamic Barcodes**

If you don't have the Dynamic Barcodes plug-in, you can still use Illustrator to do the following operations without rendering your barcode invalid.

If you don't have Dynamic Barcodes installed, you will **not** be able to

- move or scale the object using the Selection tool
- move or distort it (reflect, shear or scale)
- change a color

You will be able to

- expand the bar code
- Rotate by Selection or Free transform - this can lead to inconsistent results so we recommend not doing this.
- move, rotate and distort by the Transform Each command - this can lead to inconsistent results so we recommend not doing this.
- enclose it in the Envelope and distort
- delete it
- copy and paste it

If the Dynamic Barcode plugin is installed, but without a valid license, you will be able to do everything that is allowed by the plugin, except modifying the content. This means for example moving and rotating is allowed, but due to the bar code protection, any potentially dangerous operations such as scale, reflect or shear are not allowed. You will also be able to change the color of the bar code.

**Unprotecting a Dynamic Barcodes Barcode for Further Editing**

You can expand your Dynamic Barcodes barcode to a regular Illustrator group art to be able to edit it further, but this is not recommended as it will **remove the barcode's protection**.

**Attention:** It will then be possible to make modifications that **might render the barcode invalid**.

1. To do this, go to **Object > Expand...** in the Illustrator menu.
2. Choose the object's characteristics to expand, then click **OK**.
This turns your barcode into a regular Illustrator object. You can now for example edit each bar of the barcode individually.

6.4 Exporting Documents with Barcodes

If you are using other Esko applications, you can export Illustrator documents containing barcodes to the Esko Normalized PDF format, preserving the barcodes' information and editability.

6.4.1 Viewing Barcode Information in Other Esko Applications

1. Export your Illustrator document to the Esko Normalized PDF format:
   - If you have Automation Engine, use Shuttle to launch the document into your chosen workflow. This converts it to Normalized PDF automatically.

   **Note:** See the Adobe Illustrator Client documentation for setup information.
   - If you don't have Automation Engine, use File > Export and choose Normalized PDF as the export format.

2. Select (in Automation Engine) or open (in PackEdge / Acrobat) your document and open the XMP information as explained below:

<table>
<thead>
<tr>
<th>If you have...</th>
<th>go to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automation Engine</td>
<td>File &gt; Info.</td>
</tr>
<tr>
<td>PackEdge</td>
<td>File &gt; XMP Info.</td>
</tr>
<tr>
<td>the Esko XMP plug-in in Adobe Acrobat</td>
<td>Esko &gt; XMP Document Info...</td>
</tr>
</tbody>
</table>

3. Click Barcodes in the Data type column (as below in PackEdge) to show the barcode information.
6.4.2 Editing Barcodes in Other Esko Applications

The Dynamic Barcodes functionality is available both as a DeskPack plug-in and in PackEdge.

- To edit your document containing barcodes in PackEdge:
  a) Export your Illustrator document to the Esko Normalized PDF format:
     - If you have Automation Engine, use Shuttle to launch the document into your chosen workflow. This converts it to Normalized PDF automatically.
     
     **Note:** See the Adobe Illustrator Client documentation for setup information.

     - If you don't have Automation Engine, use File > Export and choose Normalized PDF as the export format.
  b) Open your document in PackEdge.
  c) Go to Production > Bar Code... to edit your barcode as you would edit it with Dynamic Barcodes.

For more information, see the Shuttle and PackEdge documentation.
7. Barcode Types and Parameters

7.1 Supported Barcode Types

**General Purpose Barcodes**

<table>
<thead>
<tr>
<th>1D</th>
<th>2D</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Code 39</em></td>
<td><em>DataMatrix</em></td>
</tr>
<tr>
<td><em>2 of 5</em></td>
<td><em>QR</em></td>
</tr>
<tr>
<td><em>Interleaved 2 of 5</em></td>
<td><em>MicroQR</em></td>
</tr>
<tr>
<td><em>Codabar</em></td>
<td></td>
</tr>
<tr>
<td><em>Code 128</em></td>
<td></td>
</tr>
<tr>
<td><em>Code 128 (long)</em></td>
<td></td>
</tr>
<tr>
<td><em>MSI</em></td>
<td></td>
</tr>
</tbody>
</table>

**Retail Barcodes**

<table>
<thead>
<tr>
<th>1D</th>
<th>2D</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>EAN 13</em></td>
<td><em>GS1 DataMatrix</em></td>
</tr>
<tr>
<td><em>EAN 8</em></td>
<td></td>
</tr>
<tr>
<td><em>UPC-A</em></td>
<td></td>
</tr>
<tr>
<td><em>UPC-E</em></td>
<td></td>
</tr>
<tr>
<td><em>GS1 DataBar Omnidirectional</em></td>
<td></td>
</tr>
<tr>
<td><em>GS1 DataBar Truncated</em></td>
<td></td>
</tr>
<tr>
<td><em>GS1 DataBar Stacked</em></td>
<td></td>
</tr>
<tr>
<td><em>GS1 DataBar Stacked Omnidirectional</em></td>
<td></td>
</tr>
<tr>
<td><em>GS1 DataBar Limited</em></td>
<td></td>
</tr>
<tr>
<td><em>GS1 DataBar Expanded</em></td>
<td></td>
</tr>
<tr>
<td><em>GS1 DataBar Expanded Stacked</em></td>
<td></td>
</tr>
</tbody>
</table>
### Dynamic Barcodes for Adobe Illustrator

#### 1D
- GS1 128
- GS1 U.S. Coupon Interim
- M+S 7
- Marks & Spencer

#### 2D

<table>
<thead>
<tr>
<th>Pharmacy, Healthcare and Cosmetic Barcodes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1D</strong></td>
</tr>
<tr>
<td>- NDC / HRI</td>
</tr>
<tr>
<td>- EAN 13 Swissmedic</td>
</tr>
<tr>
<td>- Laetus Pharma Code</td>
</tr>
<tr>
<td>- CLF-8</td>
</tr>
<tr>
<td>- HIBC 39</td>
</tr>
<tr>
<td>- HIBC 128</td>
</tr>
<tr>
<td>- Paraf Italy</td>
</tr>
<tr>
<td>- PZN</td>
</tr>
<tr>
<td>- PZN8</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Shipment Container Barcodes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1D</strong></td>
</tr>
<tr>
<td>- ITF-14</td>
</tr>
<tr>
<td>- ITF-16</td>
</tr>
<tr>
<td>- UPC-SCS</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Identity Document Barcode</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>2D</strong></td>
</tr>
<tr>
<td>- PDF417</td>
</tr>
</tbody>
</table>
### 7.1.1 GS1 Application Identifiers

These are the GS1 Application Identifiers available in Dynamic Barcodes:

<table>
<thead>
<tr>
<th>GS1 AI</th>
<th>Data Content</th>
<th>Format (FNC1)</th>
<th>FNC1 Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>00</td>
<td>Serial Shipping Container Code (SSCC)</td>
<td>N2+N18</td>
<td></td>
</tr>
<tr>
<td>01</td>
<td>Global Trade Item Number (GTIN)</td>
<td>N2+N14</td>
<td></td>
</tr>
<tr>
<td>02</td>
<td>GTIN of Contained Trade Items</td>
<td>N2+N14</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Batch or Lot Number</td>
<td>N2+X..20</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>11</td>
<td>Production Date (YYMMDD)</td>
<td>N2+N6</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Due Date (YYMMDD)</td>
<td>N2+N6</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Packaging Date (YYMMDD)</td>
<td>N2+N6</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Best Before Date (YYMMDD)</td>
<td>N2+N6</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Sell By Date (YYMMDD)</td>
<td>N2+N6</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Expiration Date (YYMMDD)</td>
<td>N2+N6</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Internal product variant</td>
<td>N2+N2</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>Serial Number</td>
<td>N2+X..20</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>22</td>
<td>Consumer product variant</td>
<td>N2+X..20</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>240</td>
<td>Additional Item Identification</td>
<td>N3+X..30</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>241</td>
<td>Customer Part Number</td>
<td>N3+X..30</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>242</td>
<td>Made-to-Order Variation Number</td>
<td>N3+N..6</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>243</td>
<td>Packaging Component Number</td>
<td>N3+X..20</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>250</td>
<td>Secondary Serial Number</td>
<td>N3+X..30</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>251</td>
<td>Reference to Source Entity</td>
<td>N3+X..30</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>253</td>
<td>Global Document Type Identifier (GDTI)</td>
<td>N3+N13+X..17</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>254</td>
<td>GLN Extension Component</td>
<td>N3+X..20</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>255</td>
<td>Global Coupon Number (GCN)</td>
<td>N3+N13+N..12</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>30</td>
<td>Variable Count of Items (Variable Measure Trade Item)</td>
<td>N2+N..8</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>310n</td>
<td>Net weight, kilograms (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>311n</td>
<td>Length or first dimension, metres (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>312n</td>
<td>Width, diameter, or second dimension, metres (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>313n</td>
<td>Depth, thickness, height, or third dimension, metres (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>314n</td>
<td>Area, square metres (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
<td>Example</td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------</td>
<td></td>
</tr>
<tr>
<td>315n</td>
<td>Net volume, litres (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>316n</td>
<td>Net volume, cubic metres (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>320n</td>
<td>Net weight, pounds (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>321n</td>
<td>Length or first dimension, inches (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>322n</td>
<td>Length or first dimension, feet (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>323n</td>
<td>Length or first dimension, yards (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>324n</td>
<td>Width, diameter, or second dimension, inches (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>325n</td>
<td>Width, diameter, or second dimension, feet (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>326n</td>
<td>Width, diameter, or second dimension, yards (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>327n</td>
<td>Depth, thickness, height, or third dimension, inches (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>328n</td>
<td>Depth, thickness, height, or third dimension, feet (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>329n</td>
<td>Depth, thickness, height, or third dimension, yards (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>330n</td>
<td>Logistic weight, kilograms</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>331n</td>
<td>Length or first dimension, metres</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>332n</td>
<td>Width, diameter, or second dimension, metres</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>333n</td>
<td>Depth, thickness, height, or third dimension, metres</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>334n</td>
<td>Area, square metres</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>335n</td>
<td>Logistic volume, litres</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>336n</td>
<td>Logistic volume, cubic metres</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>337n</td>
<td>Kilograms per square metre</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>340n</td>
<td>Logistic weight, pounds</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>341n</td>
<td>Length or first dimension, inches</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>342n</td>
<td>Length or first dimension, feet</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>343n</td>
<td>Length or first dimension, yards</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>344n</td>
<td>Width, diameter, or second dimension, inches</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>345n</td>
<td>Width, diameter, or second dimension, feet</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>346n</td>
<td>Width, diameter, or second dimension, yard</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
<td>Format</td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>-------------------------------------------------------------------------------------------------</td>
<td>--------</td>
<td></td>
</tr>
<tr>
<td>347n</td>
<td>Depth, thickness, height, or third dimension, inches</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>348n</td>
<td>Depth, thickness, height, or third dimension, feet</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>349n</td>
<td>Depth, thickness, height, or third dimension, yards</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>350n</td>
<td>Area, square inches (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>351n</td>
<td>Area, square feet (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>352n</td>
<td>Area, square yards (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>353n</td>
<td>Area, square inches</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>354n</td>
<td>Area, square feet</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>355n</td>
<td>Area, square yards</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>356n</td>
<td>Net weight, troy ounces (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>357n</td>
<td>Net weight (or volume), ounces (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>358n</td>
<td>Net volume, quarts (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>359n</td>
<td>Net volume, gallons U.S. (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>360n</td>
<td>Logistic volume, quarts</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>361n</td>
<td>Logistic volume, gallons U.S.</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>362n</td>
<td>Logistic volume, cubic inches (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>363n</td>
<td>Logistic volume, cubic feet</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>364n</td>
<td>Logistic volume, cubic yards</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>365n</td>
<td>Net volume, cubic inches (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>366n</td>
<td>Net volume, cubic feet (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>367n</td>
<td>Net volume, cubic yards</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>368n</td>
<td>Net volume, cubic inches (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>369n</td>
<td>Net volume, cubic feet (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>Count of Trade Items</td>
<td>N2+N..8 (FNC1)</td>
<td></td>
</tr>
<tr>
<td>390n</td>
<td>Applicable Amount Payable or Coupon Value, local currency</td>
<td>N4+N..15 (FNC1)</td>
<td></td>
</tr>
<tr>
<td>391n</td>
<td>Applicable Amount Payable with ISO Currency Code</td>
<td>N4+N3+N..15 (FNC1)</td>
<td></td>
</tr>
<tr>
<td>392n</td>
<td>Applicable Amount Payable, single monetary area (Variable Measure Trade Item)</td>
<td>N4+N..15 (FNC1)</td>
<td></td>
</tr>
<tr>
<td>393n</td>
<td>Applicable Amount Payable with ISO Currency Code (Variable Measure Trade Item)</td>
<td>N4+N3+N..15 (FNC1)</td>
<td></td>
</tr>
<tr>
<td>394n</td>
<td>Percentage discount of a coupon</td>
<td>N4+N4   (FNC1)</td>
<td></td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
<td>Format</td>
<td>Function</td>
</tr>
<tr>
<td>------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------</td>
<td>----------</td>
</tr>
<tr>
<td>400</td>
<td>Customer's Purchase Order Number</td>
<td>N3+X..30</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>401</td>
<td>Global Identification Number for Consignment (GINC)</td>
<td>N3+X..30</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>402</td>
<td>Global Shipment Identification Number (GSIN)</td>
<td>N3+N17</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>403</td>
<td>Routing Code</td>
<td>N3+X..30</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>410</td>
<td>Ship to - Deliver to Global Location Number</td>
<td>N3+N13</td>
<td></td>
</tr>
<tr>
<td>411</td>
<td>Bill to - Invoice to Global Location Number</td>
<td>N3+N13</td>
<td></td>
</tr>
<tr>
<td>412</td>
<td>Purchased from Global Location Number</td>
<td>N3+N13</td>
<td></td>
</tr>
<tr>
<td>413</td>
<td>Ship for - Deliver for - Forward to Global Location Number</td>
<td>N3+N13</td>
<td></td>
</tr>
<tr>
<td>414</td>
<td>Identification of a Physical Location - Global Location Number</td>
<td>N3+N13</td>
<td></td>
</tr>
<tr>
<td>415</td>
<td>Global Location Number of the Invoicing Party</td>
<td>N3+N13</td>
<td></td>
</tr>
<tr>
<td>416</td>
<td>GLN of the production or service location</td>
<td>N3+N13</td>
<td></td>
</tr>
<tr>
<td>420</td>
<td>Ship to - Deliver to Postal Code Within a Single Postal Authority</td>
<td>N3+X..20</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>421</td>
<td>Ship to - Deliver to Postal Code with ISO Country Code</td>
<td>N3+N3+N..12</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>422</td>
<td>Country of Origin of a Trade Item</td>
<td>N3+N3</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>423</td>
<td>Country of Initial Processing</td>
<td>N3+N3+N..12</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>424</td>
<td>Country of Processing</td>
<td>N3+N3</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>425</td>
<td>Country of Disassembly</td>
<td>N3+N3+N..12</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>426</td>
<td>Country Covering full Process Chain</td>
<td>N3+N3</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>427</td>
<td>Country Subdivision of Origin</td>
<td>N3+X..3</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>7001</td>
<td>NATO Stock Number (NSN)</td>
<td>N4+N13</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>7002</td>
<td>UN/ECE Meat Carcasses and Cuts Classification</td>
<td>N4+X..30</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>7003</td>
<td>Expiration Date and Time</td>
<td>N4+N10</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>7004</td>
<td>Active Potency</td>
<td>N4+N..4</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>7005</td>
<td>Catch Area</td>
<td>N4+X..12</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>7006</td>
<td>First Freeze Date</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>7007</td>
<td>Harvest Date</td>
<td>N4+N6..12</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>7008</td>
<td>Species for Fishery Purposes</td>
<td>N4+X..3</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>7009</td>
<td>Fishing Gear Type</td>
<td>N4+N..10</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>7010</td>
<td>Production Method</td>
<td>N4+X..2</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>7020</td>
<td>Refurbishment lot ID</td>
<td>N4+X..20</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>7021</td>
<td>Functional status</td>
<td>N4+X..20</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>7022</td>
<td>Revision status</td>
<td>N4+X..20</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>7023</td>
<td>Global Individual Asset Identifier (GIAI) of an assembly</td>
<td>N4+X..30</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>703s</td>
<td>Number of Processor with ISO Country Code</td>
<td>N4+N3+N..27</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
<td>Format</td>
<td>FNC1</td>
</tr>
<tr>
<td>-------</td>
<td>------------------------------------------------------------------------------</td>
<td>-----------------------</td>
<td>------</td>
</tr>
<tr>
<td>710</td>
<td>National Healthcare Reimbursement Number (NHRN) – Germany PZN</td>
<td>N3+X..20</td>
<td></td>
</tr>
<tr>
<td>711</td>
<td>National Healthcare Reimbursement Number (NHRN) – France CIP</td>
<td>N3+X..20</td>
<td></td>
</tr>
<tr>
<td>712</td>
<td>National Healthcare Reimbursement Number (NHRN) – Spain CN</td>
<td>N3+X..20</td>
<td></td>
</tr>
<tr>
<td>713</td>
<td>National Healthcare Reimbursement Number (NHRN) – Brasil DRN</td>
<td>N3+X..20</td>
<td></td>
</tr>
<tr>
<td>8001</td>
<td>Roll Products (Width, Length, Core Diameter, Direction, Splices)</td>
<td>N4+N14</td>
<td></td>
</tr>
<tr>
<td>8002</td>
<td>Cellular Mobile Telephone Identifier</td>
<td>N4+X..20</td>
<td></td>
</tr>
<tr>
<td>8003</td>
<td>Global Returnable Asset Identifier (GRAI)</td>
<td>N4+N14+N..16</td>
<td></td>
</tr>
<tr>
<td>8004</td>
<td>Global Individual Asset Identifier (GIAI)</td>
<td>N4+X..30</td>
<td></td>
</tr>
<tr>
<td>8005</td>
<td>Price Per Unit of Measure</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>8006</td>
<td>Identification of the Components of a Trade Item</td>
<td>N4+N14+N2+N2</td>
<td></td>
</tr>
<tr>
<td>8007</td>
<td>International Bank Account Number (IBAN)</td>
<td>N4+X..34</td>
<td></td>
</tr>
<tr>
<td>8008</td>
<td>Date and Time of Production</td>
<td>N4+N8+N..4</td>
<td></td>
</tr>
<tr>
<td>8010</td>
<td>Component / Part Identifier (CPID)</td>
<td>N4+X..30</td>
<td></td>
</tr>
<tr>
<td>8011</td>
<td>Component / Part Identifier Serial Number (CPID SERIAL)</td>
<td>N4+N..12</td>
<td></td>
</tr>
<tr>
<td>8012</td>
<td>Software version</td>
<td>N4+X..20</td>
<td></td>
</tr>
<tr>
<td>8017</td>
<td>Global Service Relation Number to identify the relationship between an organisation offering services and the provider of services</td>
<td>N4+N18</td>
<td></td>
</tr>
<tr>
<td>8018</td>
<td>Global Service Relation Number to identify the relationship between an organisation offering services and the recipient of services</td>
<td>N4+N18</td>
<td></td>
</tr>
<tr>
<td>8019</td>
<td>Service Relation Instance Number (SRIN)</td>
<td>N4+N..10</td>
<td></td>
</tr>
<tr>
<td>8020</td>
<td>Payment Slip Reference Number</td>
<td>N4+X..25</td>
<td></td>
</tr>
<tr>
<td>8110</td>
<td>Coupon Code Identification for Use in North America</td>
<td>N4+X..70</td>
<td></td>
</tr>
<tr>
<td>8111</td>
<td>Loyalty points of a coupon</td>
<td>N4+N4</td>
<td></td>
</tr>
<tr>
<td>8112</td>
<td>Paperless coupon code identification for use in North America</td>
<td>N4+X..70</td>
<td></td>
</tr>
<tr>
<td>8200</td>
<td>Extended Packaging URL</td>
<td>N4+X..70</td>
<td></td>
</tr>
<tr>
<td>90</td>
<td>Information Mutually Agreed Between Trading Partners</td>
<td>N2+X..30</td>
<td></td>
</tr>
<tr>
<td>91 to 99</td>
<td>Company Internal Information</td>
<td>N2+X..30</td>
<td></td>
</tr>
</tbody>
</table>

**Notes**

- *: The first position indicates the length (number of digits) of the GS1 Application Identifier. The following value refers to the format of the data content.
The following convention is applied:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>N</td>
<td>numeric digit</td>
</tr>
<tr>
<td>X</td>
<td>any character</td>
</tr>
<tr>
<td>N3</td>
<td>3 numeric digits, fixed length</td>
</tr>
<tr>
<td>N..3</td>
<td>up to 3 numeric digits</td>
</tr>
<tr>
<td>X..3</td>
<td>up to 3 characters</td>
</tr>
</tbody>
</table>

- **: If only year and month are available, DD must be filled with two zeroes.
- ***: The fourth digit of this GS1 Application Identifier indicates the implied decimal point position. Example:
  - 3100 Net weight in kg without a decimal point
  - 3102 Net weight in kg with two decimal points
- FNC1: All GS1 Application Identifiers indicated with (FNC1) are defined as of variable length and shall be delimited unless this Element String is the last one to be encoded in the symbol. The delimiter shall be a Function 1 Symbol Character in GS1-128 Symbology, GS1 DataBar Expanded Versions and GS1 Composite Symbology and should be a Function 1 Symbol Character in GS1 DataMatrix and GS1 QR Code Symbology.

7.2 Barcode Types

To create a barcode of a specific type, select it in the **Barcode Type** parameter. This displays parameters specific to this barcode type in the **Dynamic Barcodes** dialog.

7.2.1 2 of 5

**About this Barcode...**

2 of 5 is a numeric self-checking barcode, which can have a variable length. This barcode only encodes data in the bars. It is used for industrial applications, article numbering, photo development and ticketing.

![Barcode Example](00000)

**Parameters**

**General Parameters**

- *Rotation* on page 81
- *Code* on page 81

**Text Parameters**

- *Add Human Readable Characters* on page 82
- *Font Family, Style and Size* on page 84
Dynamic Barcodes for Adobe Illustrator

• Alignment on page 84
• Vertical Offset on page 84

Additional Parameters
• Bar Width Reduction on page 85
• Device Compensation on page 86
• Height on page 86
• Characters per unit on page 87
• Ratio on page 89
• Narrow Bar on page 89
• Box on page 93

7.2.2 CLF-8

About this Barcode...
The CLF-8 barcode is part of the same barcode family as the Laetus Pharma Code. It is used in the pharmaceutical industry.

Parameters
General Parameters
• Rotation on page 81
• Code on page 81

Text Parameters
• Add Human Readable Characters on page 82
• Font Family, Style and Size on page 84
• Alignment on page 84
• Vertical Offset on page 84

Additional Parameters
• Bar Width Reduction on page 85
• Device Compensation on page 86
• Height on page 86
• Ratio on page 89
• Narrow Bar on page 89
• Wide Bar on page 89
• Gap on page 89
7.2.3 Codabar

About this Barcode...
The Codabar barcode is commonly used in libraries, blood banks, and the air parcel business. It can encode up to 126 characters of data and two control characters, using digits and the ",", ",", ",", "(" and "," characters.

Parameters
General Parameters
- Rotation on page 81
- Code on page 81

Text Parameters
- Add Human Readable Characters on page 82
- Font Family, Style and Size on page 84
- Alignment on page 84
- Vertical Offset on page 84

Additional Parameters
- Rational (Constant Bar Width): By enabling this option, you can create a "Rational" Codabar bar code.
- Use “992” Prod. Family in UPC on page 85
- Bar Width Reduction on page 85
- Device Compensation on page 86
- Height on page 86
- Characters per unit on page 87
- Ratio on page 89
- Narrow Bar on page 89
- Box on page 93

7.2.4 Code 128

About this Barcode...
Code 128 is a variable length, high density, alphanumeric barcode. It has the second highest density of all the 1D barcodes (after the GS1 Databar Expanded).
It can contain a set of control characters. These control characters can change the character encoding type. In the absence of control characters, the encoding type is chosen automatically, to optimize the content encoding.

To force the usage of the code-set A, precede your data with the \texttt{[a]} control character. To force the usage of the code-set B, precede your data with the \texttt{[b]} control character. To obtain an optimal utilization of the code-sets A and B but prevent the usage of the space saving code-set C, use the Code 128 (long) barcode type instead.

### Parameters

**General Parameters**
- \textit{Rotation} on page 81
- \textit{Code} on page 81

**Text Parameters**
- \textit{Add Human Readable Characters} on page 82
- \textit{Light Margin Indicator} on page 83
- \textit{Font Family, Style and Size} on page 84
- \textit{Alignment} on page 84
- \textit{Vertical Offset} on page 84

**Additional Parameters**
- \textit{Bar Width Reduction} on page 85
- \textit{Device Compensation} on page 86
- \textit{Height} on page 86
- \textit{Characters per unit} on page 87
- \textit{Narrow Bar} on page 89
- \textit{Box} on page 93

### 7.2.5 Code 128 (long)

**About this Barcode...**
Code 128 (long) is a version of Code 128 that doesn’t use the space-saving “C” character set. This makes Code 128 (long) barcodes generally longer.
Parameters

General Parameters
- Rotation on page 81
- Code on page 81

Text Parameters
- Add Human Readable Characters on page 82
- Light Margin Indicator on page 83
- Font Family, Style and Size on page 84
- Alignment on page 84
- Vertical Offset on page 84

Additional Parameters
- Bar Width Reduction on page 85
- Device Compensation on page 86
- Height on page 86
- Characters per unit on page 87
- Narrow Bar on page 89
- Box on page 93

7.2.6 Code 39

About this Barcode...
Code 39 is a popular barcode in industrial barcoding systems, mainly in the U.S.A. It is used in the non-retail industry, particularly in the manufacturing, military, and health sectors. It can encode alphanumeric data.
7.2.7 DataMatrix

About this Barcode...

DataMatrix is used for encoding large amounts of alphanumeric data and / or marking small objects. It can encode all the standard ASCII and extended ASCII characters.

The DataMatrix symbol size can adjust automatically depending on the amount of data.

Dynamic Barcodes doesn't generate human readable characters for DataMatrix symbols. The data to be encoded in a DataMatrix symbol can contain an FNC1 character but only at the beginning of the data.

Note: Dynamic Barcodes always generates DataMatrix symbols with the recommended ECC200 error correction scheme.
7.2.8 EAN 8

About this Barcode...
EAN 8 is an abbreviated version of EAN 13, for use on smaller packages. It contains eight digits of data.

Parameters
General Parameters
- Rotation on page 81
- Code on page 81

Text Parameters
- Add Human Readable Characters on page 82
- Light Margin Indicator on page 83
- Font Family, Style and Size on page 84
- Vertical Offset on page 84

Additional Parameters
- Bar Width Reduction on page 85
- Device Compensation on page 86
- Magnification on page 86
- Height on page 86
Dynamic Barcodes for Adobe Illustrator

- **Snap Bars to Output Resolution** on page 90
- **Box** on page 93

### 7.2.9 EAN 13

**About this Barcode...**

European Article Numbering system or EAN is the standard for article numbering in Europe. It is also used in Japan where it is called JAN.

**Note:** EAN is the European equivalent of the UPC system in the U.S.A. and Canada. Both systems use the same size requirements and a similar encoding scheme. This means that most European and American retail barcode scanners can read both EAN and UPC barcodes. For more information on UPC, see **UPC-A** on page 78.

An EAN 13 is a numeric barcode of thirteen digits, and can have two or five additional digits.

![EAN 13 example](image)

**Parameters**

**General Parameters**
- **Rotation** on page 81
- **Code** on page 81

**Text Parameters**
- **Add Human Readable Characters** on page 82
- **Light Margin Indicator** on page 83
- **Font Family, Style and Size** on page 84
- **Vertical Offset** on page 84

**Additional Parameters**
7.2.10 EAN 13 Swissmedic

About this Barcode...

EAN 13 Swissmedic is an EAN 13 barcode used for items licensed by the Swiss Agency for Therapeutic Products.

It always starts with "7680", uses a specific text positioning and adds the text "swissmedic" below the code.

For EAN 13 Swissmedic barcodes, only the default font settings can be used.
7.2.11 GS1 128

About this Barcode...

GS1 128 (formerly EAN 128) is a Code 128 barcode designed primarily to identify products. It contains one or more FNC1 (GS1 Function Code 1) control characters and Application Identifiers. It shows parentheses around the human readable interpretation of the Application Identifiers, but those parentheses are not encoded in the barcode.

It is alphanumeric and can also contain composite symbols.

Parameters

General Parameters

• Rotation on page 81
• Code on page 81
• Composite Component on page 82

Text Parameters

• Add Human Readable Characters on page 82
• Put on Top on page 83
• Multiple Text Lines on page 83
• Font Family, Style and Size on page 84
• Alignment on page 84
• Vertical Offset on page 84
Additional Parameters

- *Bar Width Reduction* on page 85
- *Device Compensation* on page 86
- *Magnification* on page 86
- *Height* on page 86
- *Narrow Bar* on page 89
- *Snap Bars to Output Resolution* on page 90
- *Box* on page 93

7.2.12 GS1 DataBar Omnidirectional

**About this Barcode...**

Barcodes of the GS1 DataBar family (formerly Reduced Space Symbols or RSS) can identify small items, and encode more information than the current EAN or UPC barcodes. They can include GS1 Application Identifiers such as serial numbers, lot numbers, expiration dates...

**Note:** GS1 DataBar codes are expected to replace most common EAN and UPC barcodes from 2010.

GS1 DataBar Omnidirectional encodes Global Trade Item Numbers (GTIN) in a linear symbol that can be scanned omnidirectionally by suitably programmed slot scanners.

---

**Parameters**

**General Parameters**

- *Rotation* on page 81
- *Code* on page 81
- *Composite Component* on page 82

**Text Parameters**

- *Add Human Readable Characters* on page 82
- *Put on Top* on page 83
- *Multiple Text Lines* on page 83
7.2.13 GS1 DataBar Stacked

About this Barcode...

GS1 DataBar Stacked is a variation of the GS1 DataBar barcode, that is stacked in two rows and used when the normal barcode would be too wide for the product.

Parameters

General Parameters

- Rotation on page 81
- Code on page 81
- Composite Component on page 82

Text Parameters

- Add Human Readable Characters on page 82
- Multiple Text Lines on page 83
- Font Family, Style and Size on page 84
- Alignment on page 84
- Vertical Offset on page 84

Additional Parameters

- Bar Width Reduction on page 85
- Device Compensation on page 86
- Narrow Bar on page 89
7.2.14 GS1 DataBar Stacked Omnidirectional

About this Barcode...
GS1 DataBar14 Stacked Omnidirectional is taller version of GS1 DataBar14 Stacked, that can be read by omnidirectional scanners.

Parameters
General Parameters
- Rotation on page 81
- Code on page 81
- Composite Component on page 82

Text Parameters
- Add Human Readable Characters on page 82
- Put on Top on page 83
- Multiple Text Lines on page 83
- Font Family, Style and Size on page 84
- Alignment on page 84
- Vertical Offset on page 84

Additional Parameters
- Bar Width Reduction on page 85
- Device Compensation on page 86
- Narrow Bar on page 89
- Snap Bars to Output Resolution on page 90

7.2.15 GS1 DataBar Truncated

About this Barcode...
GS1 DataBar Truncated (formerly RSS Limited) is similar to GS1 DataBar but the height of its bars is truncated.
It encodes Global Trade Item Numbers in a smaller symbol for use on small items. It cannot be scanned omnidirectionally.

Parameters

General Parameters
- Rotation on page 81
- Code on page 81
- Composite Component on page 82

Text Parameters
- Add Human Readable Characters on page 82
- Put on Top on page 83
- Multiple Text Lines on page 83
- Font Family, Style and Size on page 84
- Alignment on page 84
- Vertical Offset on page 84

Additional Parameters
- Bar Width Reduction on page 85
- Device Compensation on page 86
- Narrow Bar on page 89
- Snap Bars to Output Resolution on page 90

7.2.16 GS1 DataBar Expanded

About this Barcode...
GS1 DataBar Expanded (formerly RSS Expanded) encodes regular barcode data ("primary item identification" data) and Application Identifiers. It can encode alphanumeric characters. This barcode can be scanned omnidirectionally by suitably programmed slot scanners.
7.2.17 GS1 DataBar Expanded Stacked

About this Barcode...

GS1 DataBar Expanded Stacked can encode the same amount of data as GS1 DataBar Expanded, but can also “stack” the barcode into several rows to save space.
Dynamic Barcodes for Adobe Illustrator

- **Rotation** on page 81
- **Code** on page 81
- **Composite Component** on page 82

**Text Parameters**
- **Add Human Readable Characters** on page 82
- **Put on Top** on page 83
- **Multiple Text Lines** on page 83
- **Font Family, Style and Size** on page 84
- **Alignment** on page 84
- **Vertical Offset** on page 84

**Additional Parameters**
- **Max. Row Width** on page 85
- **Bar Width Reduction** on page 85
- **Device Compensation** on page 86
- **Narrow Bar** on page 89
- **Snap Bars to Output Resolution** on page 90

### 7.2.18 GS1 DataBar Limited

**About this Barcode...**

GS1 Databar Limited is smaller than the GS1 DataBar barcode and can only encode Global Trade Item Numbers whose data part starts with “1”.

![GS1 DataBar Limited](image)

**Parameters**

**General Parameters**
- **Rotation** on page 81
- **Code** on page 81
- **Composite Component** on page 82

**Text Parameters**
- **Add Human Readable Characters** on page 82
- **Put on Top** on page 83
7.2.19 GS1 DataMatrix

About this Barcode...
The GS1 Data Matrix barcode is a high density, high capacity, scalable 2D barcode. It is used to concentrate a lot of (alphanumeric) information in a very small space.

Parameters

General Parameters
• Rotation on page 81
• Code on page 81

Text Parameters
• Add Human Readable Characters on page 82
• Put on Top on page 83
• Multiple Text Lines on page 83
• Light Margin Indicator on page 83
• Font Family, Style and Size on page 84
• Alignment on page 84
• Vertical Offset on page 84

Additional Parameters
• Bar Width Reduction on page 85
• Device Compensation on page 86
• Narrow Bar on page 89
• Snap Bars to Output Resolution on page 90
7.2.20 GS1 QR

About this Barcode...

The GS1 QR barcode is a high density, high capacity, scalable 2D barcode. It is used to assemble multiple GS1 Application Identifiers to a barcode with limited space needs. The GS1 QR barcode can contain numbers, 0 - 9, upper case letters A-Z, and nine special characters: space $ % * + - . /

For more technical information on the QR code, see QR on page 74

Parameters

General Parameters

• Rotation on page 81
• Code on page 81

Text Parameters

• Add Human Readable Characters on page 82
• Put on Top on page 83
• Multiple Text Lines on page 83
• Light Margin Indicator on page 83
• Font Family, Style and Size on page 84
• Alignment on page 84
• Vertical Offset on page 84

Additional Parameters

• Bar Width Reduction on page 85
• Device Compensation on page 86
• Symbol Type on page 91
• Cell Size on page 91
• Width / Total Height on page 91
• Box on page 93

Specific Parameters

Minimum Symbol Size

Choose the number of cells to use for your barcode (in the format “horizontal cells x vertical cells”).

• Cell Size on page 91
• Width / Total Height on page 91
• Box on page 93
**Note:** If the number of cells you choose for your symbol is too small to encode the data you entered in **Code**, Dynamic Barcodes will use a bigger symbol size automatically.

### Error Correction

Error correction adds check sums to the barcode to detect and correct incorrect data. You can choose one of the following **Error correction** levels:

- **Level L**: 7% of codewords can be restored.
- **Level M**: 15% of codewords can be restored.
- **Level Q**: 25% of codewords can be restored.
- **Level H**: 30% of codewords can be restored.

**Note:** Keep in mind that a higher correction level makes the barcode bigger (as more check sums are added to the barcode) and may limit the maximum length of the encoded data.

### Width / Height

The **Width** and **Height** parameters depend on the **Cell Size** and the number of cells used for the symbol (**Minimum Symbol Size**).

For example, a symbol of 25 x 25 cells where each cell is 2 mm gives a Width and Height of 50 x 50 mm.

---

**7.2.21 GS1 U.S. Coupon Interim**

**About this Barcode...**

GS1 U.S. Coupon Interim is an interim coupon barcode. It is used during the transition between UPC-A coupons and the new GS1 Databar Expanded Stacked coupons, that can encode more information.

It is made of both an old UPC-A coupon barcode, and a new Databar Expanded Stacked coupon barcode, to be readable by both old and new scanners.

---

**Parameters**

**General Parameters**

- **Rotation** on page 81
- **Code** on page 81

**Text Parameters**
7.2.22 HIBC 128

About this Barcode...

This barcode is based on the Code 128 symbology. It encodes the organization's primary and / or secondary Labeler Identification Code (LIC). This encoding begins with the “+” character. If both primary and secondary Labeler Identification Codes are encoded in one barcode, they are divided by the “/” character.
7.2.23 HIBC 39

About this Barcode...
This barcode is based on the Code 39 symbology.
It encodes the organization's primary and / or secondary Labeler Identification Code (LIC). This encoding begins with the “+” character. If both primary and secondary Labeler Identification Codes are encoded in one barcode, they are divided by the “/” character.

Parameters
General Parameters
• Rotation on page 81
• Code on page 81

Text Parameters
• Add Human Readable Characters on page 82
• Font Family, Style and Size on page 84
• Vertical Offset on page 84

Additional Parameters
• Bar Width Reduction on page 85
• Device Compensation on page 86
• Magnification on page 86
• Height on page 86
• Snap Bars to Output Resolution on page 90
• Box on page 93

7.2.24 ITF-14

About this Barcode...
ITF-14 is a standardized version of the Interleaved 2 of 5 barcode, containing 14 digits, the last being a check digit.
Parameters

General Parameters
• Rotation on page 81
• Code on page 81

Text Parameters
• Add Human Readable Characters on page 82
• Font Family, Style and Size on page 84
• Vertical Offset on page 84

Additional Parameters
• Text Format on page 85
• Bar Width Reduction on page 85
• Device Compensation on page 86
• Magnification on page 86
• Height on page 86
• Snap Bars to Output Resolution on page 90
• Total Height on page 92
• Smax / Smin on page 92
• Box on page 93

7.2.25 ITF-16

About this Barcode...
ITF-16 is a standardized version of the Interleaved 2 of 5 barcode, containing 16 digits, the last being a check digit.
Parameters

General Parameters
• Rotation on page 81
• Code on page 81

Text Parameters
• Add Human Readable Characters on page 82
• Font Family, Style and Size on page 84
• Vertical Offset on page 84

Additional Parameters
• Text Format on page 85
• Bar Width Reduction on page 85
• Device Compensation on page 86
• Magnification on page 86
• Height on page 86
• Snap Bars to Output Resolution on page 90
• Total Height on page 92
• Smax / Smin on page 92
• Box on page 93

7.2.26 Interleaved 2 of 5

About this Barcode...
Interleaved 2 of 5 (or Int. 2 of 5) is a barcode originally used for transportation packaging, that can have any even number of digits. Since this type of packaging consists mainly of cardboard boxes printed in low quality, the Interleaved 2 of 5 barcode is more tolerant to distortion than other barcodes.
Dynamic Barcodes for Adobe Illustrator

7.2.27 Laetus Pharma Code

About this Barcode...
This barcode was developed specifically to meet the requirements of the pharmaceutical packaging process. It has established itself as the worldwide pharmaceutical industry barcode standard. It can encode numeric or binary data.

Parameters
Laetus Pharma

General Parameters
• Rotation on page 81
• Code on page 81

Text Parameters
• Add Human Readable Characters on page 82
• Font Family, Style and Size on page 84
• Alignment on page 84
• Vertical Offset on page 84

Additional Parameters
• Miniature: Use this option to create a miniature version of the bar code
7.2.28 M+S 7

About this Barcode...
The M+S 7 barcode is an EAN 8 barcode modified by Marks & Spencer’s, for use on own-brand products sold in their stores.

To make the M+S 7 barcode, the initial “0” is removed and the extra letters “M” and “S” are added to the human readable characters.

This means that the human readable characters contain seven digits plus the “M” and “S” letters.

Note: This doesn't affect the data encoded in the barcode (it still encodes eight digits), so you should enter eight digits when creating a M+S 7 barcode.
• Vertical Offset on page 84

Additional Parameters
• Bar Width Reduction on page 85
• Device Compensation on page 86
• Magnification on page 86
• Height on page 86
• Snap Bars to Output Resolution on page 90
• Box on page 93

7.2.29 MSI

About this Barcode...
MSI, also known as Modified Plessey, was developed by the MSI Data Corporation, based on the original Plessey Code. It is a numeric barcode used primarily to mark retail shelves for inventory control.

Parameters
General Parameters
• Rotation on page 81
• Code on page 81

Text Parameters
• Add Human Readable Characters on page 82
• Font Family, Style and Size on page 84
• Alignment on page 84
• Vertical Offset on page 84

Additional Parameters
• Bar Width Reduction on page 85
• Device Compensation on page 86
• Height on page 86
• Characters per unit on page 87
• Ratio on page 89
• Narrow Bar on page 89
7.2.30 Marks & Spencer's

About this Barcode...
The Marks & Spencer's barcode is also an EAN 8 barcode modified by Marks & Spencer's for use on own-brand products.

Parameters

General Parameters
- Rotation on page 81
- Code on page 81

Text Parameters
- Add Human Readable Characters on page 82
- Font Family, Style and Size on page 84
- Vertical Offset on page 84

Additional Parameters
- Bar Width Reduction on page 85
- Device Compensation on page 86
- Magnification on page 86
- Height on page 86
- Snap Bars to Output Resolution on page 90
- Box on page 93

7.2.31 NDC / HRI

About this Barcode...
The NDC / HRI barcode is a variant of the UPC barcode with special human readable interpretation formats compliant to the US National Drug Code definition.
Parameters

**General Parameters**
- *Rotation* on page 81
- *Code* on page 81

**Text Parameters**
- *Add Human Readable Characters* on page 82
- *Font Family, Style and Size* on page 84
- *Vertical Offset* on page 84

**Additional Parameters**
- *Text Format* on page 85
- *Bar Width Reduction* on page 85
- *Device Compensation* on page 86
- *Magnification* on page 86
- *Height* on page 86
- *Snap Bars to Output Resolution* on page 90
- *Box* on page 93

### 7.2.32 Paraf Italy

**About this Barcode...**
This barcode is a variant of Code 39 used by the Italian Health and Cosmetics Industry. It is also called Code 32.
Use **Code Base32** when your barcode data is encoded in the Base 32 format. This format uses case-insensitive alphanumeric characters to encode data.

Use **Code Base10** when your barcode data is in decimal format. Paraf Italy barcodes in decimal format should start with an "A" (included automatically by Dynamic Barcodes), have 8 digits of data and end with a check digit (calculated automatically by Dynamic Barcodes).

### Parameters

#### General Parameters
- Rotation on page 81
- Code on page 81

#### Additional Parameters
- Bar Width Reduction on page 85
- Device Compensation on page 86
- Height on page 86
- Narrow Bar on page 89
- Box on page 93

### 7.2.33 PDF417

**About this Barcode...**

PDF417 is a 2D barcode mainly used in security printing (passports, identity cards, driving licences...).

It is a “self-checking” barcode that can have different levels of error correction.

It can encode data using one of three “compaction” modes: Text (to encode all alphanumeric and punctuation characters in the ISO-8859-1 character set), Numeric (to encode only numeric characters) or Binary (to encode 8-bit characters).

It can use the three compaction modes in a single barcode if necessary, but you can choose to disable the Text and/or Numeric compaction modes.

![PDF417 Barcode Example](image-url)
Dynamic Barcodes for Adobe Illustrator

- **Height** on page 86
- **Narrow Bar** on page 89
- **Box** on page 93

**Specific Parameters**

**Columns**
You can give your barcode between 1 and 30 **Columns**. The number of columns corresponds to the number of PDF417 codewords.

**Rows**
You can give your barcode between 3 and 90 **Rows**.

**Truncated**
Choose **Truncated** to make the symbol less wide by truncating the end character (which is not part of the encoded data) and the end pattern. In the example below, the top PDF417 barcode is not truncated, and the bottom barcode is truncated (but encodes the same data).

---

**Initialize in Alpha Submode**
Choose this option to generate a “shift to Text mode” character at the beginning of the barcode when using Text compaction mode. This makes the encoding clear for barcode scanners.

**Allow Text Compaction**
Choose this to let Dynamic Barcodes switch to Text compaction mode automatically when your barcode contains text data.

This encodes the text data in your barcode more efficiently (it makes that part of your barcode smaller).

**Allow Numeric Compaction**
Choose this to let Dynamic Barcodes switch to Numeric compaction mode automatically when your barcode contains numeric data.

This encodes the numeric data in your barcode more efficiently.

**Note:**
Dynamic Barcodes can always switch to the Binary compaction mode if your barcode contains binary data.

If you don't enable either **Allow Text Compaction** or **Allow Numeric Compaction**, Dynamic Barcodes will only use Binary compaction mode.

**Error Correction Level**
Error correction adds check sums to the barcode to detect and correct incorrect data. You can choose an **Error correction level** from 0 to 8.
The higher the correction level, the more check sums are added to the barcode and the more incorrect data can be corrected. Keep in mind that a higher correction level makes the barcode bigger and may limit the maximum length of the encoded data.

**Note:** Level 0 means that there is only one check sum added to the data, so incorrect data can be detected but not corrected.

You can choose **Automatic** to let the plug-in pick the best error correction level for the data encoded.

### 7.2.34 MicroPDF417

**About this Barcode...**

MicroPDF417 is a 2D multi-row barcode derived from PDF417, for use on smaller areas. It can encode up to 150 bytes.

**Parameters**

**General Parameters**
- Rotation on page 81
- Code on page 81

**Additional Parameters**
- Bar Width Reduction on page 85
- Device Compensation on page 86
- Height on page 86
- Narrow Bar on page 89
- Snap Bars to Output Resolution on page 90
- Box on page 93

**Specific Parameters**

**Columns**
You can give your barcode between 1 and 4 **Columns**.

**Rows**
You can give your barcode between 4 and 44 **Rows**.

**Allow Text Compaction**
Choose this to let Dynamic Barcodes switch to Text compaction mode automatically when your barcode contains text data.

This encodes the text data in your barcode more efficiently (it makes that part of your barcode smaller).

**Allow Numeric Compaction**
Choose this to let Dynamic Barcodes switch to Numeric compaction mode automatically when your barcode contains numeric data.
This encodes the numeric data in your barcode more efficiently.

**Note:**
Dynamic Barcodes can always switch to the Binary compaction mode if your barcode contains binary data.
If you don't enable either Allow Text Compaction or Allow Numeric Compaction, Dynamic Barcodes will only use Binary compaction mode.

### 7.2.35 PZN

**About this Barcode...**
The PZN (Pharma-Zentral-Nummer) barcode is used for distribution of pharmaceutical and healthcare products in Germany. The PZN code is written in the format “PZN-nnnnnnn” but only the numeric part including the leading dash is encoded.

![PZN Barcode Image]

**Parameters**

**General Parameters**
- *Rotation* on page 81
- *Code* on page 81

**Text Parameters**
- *Add Human Readable Characters* on page 82
- *Font Family, Style and Size* on page 84
- *Alignment* on page 84
- *Vertical Offset* on page 84

**Additional Parameters**
- *Bar Width Reduction* on page 85
- *Device Compensation* on page 86
- *Size* on page 86
- *Height* on page 86
- *Characters per unit* on page 87
- *Ratio* on page 89
- *Narrow Bar* on page 89
7.2.36 PZN8

About this Barcode...
The PZN8 (Pharma-Zentral-Nummer) barcode is used for distribution of pharmaceutical and healthcare products in Germany. The PZN code is written in the format “PZN-nnnnnnnn” but only the numeric part including the leading dash is encoded.

Parameters

General Parameters
- Rotation on page 81
- Code on page 81

Text Parameters
- Add Human Readable Characters on page 82
- Font Family, Style and Size on page 84
- Alignment on page 84
- Vertical Offset on page 84

Additional Parameters
- Bar Width Reduction on page 85
- Device Compensation on page 86
- Size on page 86
- Height on page 86
- Characters per unit on page 87
- Ratio on page 89
- Narrow Bar on page 89
- Box on page 93

7.2.37 QR

About this Barcode...
The QR barcode is a 2-dimensional barcode used for commercial tracking and convenience-oriented applications aimed at mobile phone users (known as "mobile tagging").
QR codes storing addresses and URLs may appear in magazines, on signs, buses, business cards, or other objects... Users with a camera phone equipped with the correct reader application can scan the QR code to display text, contact information, connect to a wireless network, or open a web page in the phone's browser.

QR codes have the following structure:

• Position pattern (required)
• Alignment pattern (required)
• Timing pattern (required)
• Version information
• Format information
• Data and error correction keys

Parameters

General Parameters

• Rotation on page 81
• Code on page 81

Additional Parameters

• Bar Width Reduction on page 85
• Device Compensation on page 86
• Cell Size on page 91
• Width / Total Height on page 91
• Box on page 93
**Specific Parameters**

**Minimum Symbol Size**

Choose the number of cells to use for your barcode (in the format “horizontal cells x vertical cells”).

**Note:** If the number of cells you choose for your symbol is too small to encode the data you entered in Code, Dynamic Barcodes will use a bigger symbol size automatically.

**Error Correction**

Error correction adds check sums to the barcode to detect and correct incorrect data. You can choose one of the following **Error correction** levels:

- **Level L**: 7% of codewords can be restored.
- **Level M**: 15% of codewords can be restored.
- **Level Q**: 25% of codewords can be restored.
- **Level H**: 30% of codewords can be restored.

**Note:** Keep in mind that a higher correction level makes the barcode bigger (as more check sums are added to the barcode) and may limit the maximum length of the encoded data.

**Width / Height**

The **Width** and **Height** parameters depend on the **Cell Size** and the number of cells used for the symbol (**Minimum Symbol Size**).

For example, a symbol of 25 x 25 cells where each cell is 2 mm gives a Width and Height of 50 x 50 mm.

---

### 7.2.38 MicroQR

**About this Barcode...**

The Micro QR Code is a very small QR Code for use on smaller spaces (for example to encode the ID of printed circuit boards and electronics parts).

It works with smaller amounts of data (maximum 35 numeric characters), and uses only one position pattern.

![MicroQR code]

**Parameters**

**General Parameters**

- **Rotation** on page 81
- **Code** on page 81

**Additional Parameters**

- **Bar Width Reduction** on page 85
- **Device Compensation** on page 86
Dynamic Barcodes for Adobe Illustrator

- **Cell Size** on page 91
- **Width / Total Height** on page 91
- **Box** on page 93

### Specific Parameters

#### Minimum Symbol Size

Choose the number of cells to use for your barcode (in the format “horizontal cells x vertical cells”).

**Note:** If the number of cells you choose for your symbol is too small to encode the data you entered in **Code**, Dynamic Barcodes will use a bigger symbol size automatically.

#### Error Correction

Error correction adds check sums to the barcode to detect and correct incorrect data. You can choose one of the following **Error correction** levels:

- **Level L**: 7% of codewords can be restored.
- **Level M**: 15% of codewords can be restored.
- **Level Q**: 25% of codewords can be restored.
- **Level H**: 30% of codewords can be restored.

**Note:** Keep in mind that a higher correction level makes the barcode bigger (as more check sums are added to the barcode) and may limit the maximum length of the encoded data.

#### Width / Height

The **Width** and **Height** parameters depend on the **Cell Size** and the number of cells used for the symbol (**Minimum Symbol Size**).

For example, a symbol of 15 x 15 cells where each cell is 2 mm gives a Width and Height of 30 x 30 mm.

### 7.2.39 SICK Code

**About this Barcode...**

SICK is a bar code used in the German packaging industry. It’s a binary bar code, using a thick bar for a 0, and a thin bar for a 1. It can have up to 12 bars. It can encode numeric or binary data.

- In binary mode all digits are encoded including leading zeroes, i.e. "0001" is encoded as a three thin and one thick bar.
- In decimal mode you can define the number of bars in total, by enter e.g. "6/4". The first number (6) defines the total number of bars, the second (4) defines the value to be encoded. If you don’t define the number of bars, in other words if you enter a single number, the minimal number of bars needed for the value is used, and the code is adjusted accordingly. If you for example enter "9", the value will change to "4/9", as you need at least 4 bars to encode this value.
- The defaults follow the mostly used standard "Codetype A", for generating the "Codetype B" should be changed the barcode parameters as following: Narrow Bar to 1.25mm (from 0.5mm), Wide Bar to 3.75mm (from 1.5mm) and Gap to 2.5mm (from 1mm)
By default, the values for the Narrow Bar (0.5mm), Wide Bar (1.5mm) and Gap (1mm) are set for the mostly used standard "Codetype A". If you want to generate a SICK code using "Codetype B", you should set the Narrow Bar to 1.25mm, the Wide Bar to 3.75mm and the Gap to 2.5mm.

Parameters

General Parameters
- Rotation on page 81
- Code on page 81

Text Parameters
- Add Human Readable Characters on page 82
- Font Family, Style and Size on page 84
- Alignment on page 84
- Vertical Offset on page 84

Additional Parameters
- Bar Width Reduction on page 85
- Device Compensation on page 86
- Height on page 86
- Ratio on page 89
- Narrow Bar on page 89
- Wide Bar on page 89
- Gap on page 89
- Decimal Input on page 90
- Box on page 93

7.2.40 UPC-A

About this Barcode...
Universal Product Code or UPC is the standard for article numbering in the U.S.A. and Canada. It is similar to the EAN system and compatible with it. For more information on EAN, see EAN 13 on page 49.
UPC-A is a numeric barcode of up to twelve digits, plus two or five additional digits.

Parameters

General Parameters
- Rotation on page 81
- Code on page 81

Text Parameters
- Add Human Readable Characters on page 82
- Font Family, Style and Size on page 84
- Vertical Offset on page 84

Additional Parameters
- Bar Width Reduction on page 85
- Device Compensation on page 86
- Magnification on page 86
- Height on page 86
- Snap Bars to Output Resolution on page 90
- Box on page 93

7.2.41 UPC-E

About this Barcode...

UPC-E is an abbreviated version of UPC-A, for use on smaller packages. It is a numeric barcode of eight digits, with an optional 2 or 5 digits add-on. You can also directly enter the 12-digit code of UPC-A codes that can be represented in 8 digits.
Parameters

General Parameters
- Rotation on page 81
- Code on page 81

Text Parameters
- Add Human Readable Characters on page 82
- Font Family, Style and Size on page 84
- Vertical Offset on page 84

Additional Parameters
- Bar Width Reduction on page 85
- Device Compensation on page 86
- Magnification on page 86
- Height on page 86
- Snap Bars to Output Resolution on page 90
- Box on page 93

7.2.42 UPC-SCS

About this Barcode...
The UPC-SCS (Shipping Container Symbol) barcode is a version of the Interleaved 2 of 5 barcode that has a structure very similar to the Universal Product Code's (UPC) and specific formatting of the human readable interpretation.

Parameters

General Parameters
- Rotation on page 81
- Code on page 81

Text Parameters
- Add Human Readable Characters on page 82
7.3 Barcode Parameters

7.3.1 Rotation

To rotate your barcode by 90, 180 or 270 degrees, use the Rotation buttons.

To rotate it by any other angle, enter that angle in the Rotation field.

7.3.2 Code

Enter the data to encode in your bar code.

Dynamic Barcodes checks that the data you have entered is valid for your chosen Barcode Type. If it isn't, a warning / error will pop up.

Code for GS1 Bar Codes

When entering data to be encoded in GS1 bar codes, you can either enter Application Identifiers (AI) including the brackets, or you can enter the code without brackets, using FNC1 code at the end of each variable-length element in the data. While entering GS1 data, following remarks should be taken into account:

- Do not add the mandatory FNC1 character at the beginning of the data. Dynamic Barcodes will add it automatically.
- For GS1 bar codes intended for encoding AI (01) only, AI has to be omitted, i.e. don't enter '01' at the beginning. It doesn't matter if entered with or without brackets.
7.3.3 Composite Component

A Composite Component is a 2D symbol placed on top of a GS1 barcode, that encodes extra information (batch number, expiration date...).

If you want your barcode to have a Composite Component, enter the (alphanumeric) data to encode in this field.

**Note:** Dynamic Barcodes checks the data you enter for the Composite Component (for example to see if the Application Identifiers you entered are correct), and displays a warning if it is invalid.

7.3.4 Add Human Readable Characters

This parameter adds “human readable” characters (numeric or alphanumeric characters) under your barcode.

This is the same barcode with and without human readable characters:
7.3.5 Put on Top

This parameter allows you to put the Human Readable Characters above instead of below the barcode bars.

7.3.6 Multiple Text Lines

Select this parameter if you want the human readable characters to be printed on multiple lines below the barcode. Dynamic Barcodes will start a new line for every element of the barcode data (starting with the Application Identifier).

Note: When opening your document in PackEdge, the characters will be placed back on a single line.

7.3.7 Light Margin Indicator

This parameter adds “<” and “>” signs (or only “>” depending on the barcode type) at the bottom of your barcode. This indicates the width the barcode should have for optimal reading.
7.3.8 Font Family, Style and Size

These options can be used to define the font family, style and size to be used for the human readable characters. By choosing [default font], all other Text Parameters are disabled, as the default values are used.

Note: If the font used in a bar code is not available when opening the file, Adobe Illustrator will warn about a missing font. You can however only fix the problem using the Dynamic Barcode palette, since Adobe Illustrator’s "Find Font" feature can not be used.

7.3.9 Alignment

When using human readable characters, in combination with custom font settings, you can set text alignment to Left, Center or Right.

7.3.10 Vertical Offset

This parameter allows you to add extra space between your barcode bars and the human readable characters.
7.3.11 Use “992” Prod. Family in UPC

Enable this parameter to use the special “992” product family in your barcode (for specific offers like discounts on the customer’s next purchase or on variable weight items...).

7.3.12 Max. Row Width

Use this parameter to define how many segments of data (groups of bars encoding several digits) can fit in one row. If the barcode contains more segments, they will be stacked.

In the example below, the first barcode has a Max. Row Width of 8 segments. When reducing this to 4 segments, the segments that don't fit in the row width anymore are stacked, forming a second row (second barcode).

The GS1 Max Row Width parameter applies to the GS1 Databar Expanded Stacked component of the GS1 U.S. Coupon Interim barcode.

7.3.13 Text Format

Choose a text format for the human readable characters of your barcode.

For NDC/HRI barcodes, you can choose a variant of the U.S. National Drug Code.

For ITF-14, ITF-16 and UPC-SCS barcodes, you can choose a variant of the Shipping Container Symbol.

7.3.14 Bar Width Reduction

Use this to adjust the width of barcode bars, in order to compensate for ink bleeding when printing on your substrate.

Your printer or customer will usually provide you with the value to use. For example if your printer tells you that the line width will increase by 0.01mm, you should use a Bar Width Reduction value of 0.01 mm.

You can enter the Bar Width Reduction in microns, milliinches ("mil"), millimeters or inches.
Tip: You can enter a negative value if you want to print thicker and not thinner bars.

7.3.15 Device Compensation

Use this if your printer gave you a separate device bleed value. This parameter adjusts the bar's width to compensate for bleed caused by the plate or film making process.

You can enter the **Device Compensation** in microns, milliinches ("mil"), millimeters or inches.

**Note:** If you use both a Bar Width Reduction and a Device Compensation value, Dynamic Barcodes will add them to adjust the bar's width.

Tip: You can enter a negative value if you want to print thicker and not thinner bars.

7.3.16 Magnification

Use this parameter to increase or decrease the barcode size proportionally.

In the example below, you can see the same barcode at 80%, 100% and 120% magnification.

7.3.17 Size

Choose to give your PZN barcode a **Small**, **Normal** or **Large** size. Those are predefined sizes for this barcode. The actual Height, Characters per unit, Ratio and Narrow Bar values are shown underneath.

By selecting **Custom**, you can manually edit these four parameters.

7.3.18 Height

Enter the height to give to your barcode's bars. They need to be tall enough to be read easily by barcode scanners.

**Code 128**

In Dynamic Barcodes, you can create Code 128 barcodes shorter than the minimum height. Dynamic Barcodes will just display a warning, but if you export the document to EPF and open it in PackEdge, PackEdge will extend the barcode to its minimum required height.
Bars and Digits

For:
- EAN 8 & 13
- HIBC 128 and 39
- M+S 7, and Marks & Spencer's
- NDC / HRI
- UPC-A and UPC-E

For the bar codes listed above, the height you enter is the combined height of the bars and the human readable characters. Your barcode needs to be tall enough to be read easily by barcode scanners.

**Attention:** Do not change the **Height** of the barcode before entering a **Magnification** value. The **Height** will change again according to the **Magnification** factor you define.

### 7.3.19 Characters per unit

This parameter allows you to define your barcode's width based on the encoding of (numeric or alphanumeric) characters.

You can choose the unit to use: **micron**, **mil** (milliinches), **mm** or **inch**.

For example, choose **mm** and use 1 **Character per unit** in the Dynamic Barcodes dialog if you want the bars needed to encode one character to take up 1 mm.
Increase the **Characters per unit** value to make the barcode narrower, or decrease it to make the barcode wider. For example, if you choose **0.5 Character per unit**, the bars needed to encode one character will take up 2 mm.

**Note**: Barcodes like Interleaved 2 of 5 encode two characters together in a group of black and white bars. For these barcodes, Dynamic Barcodes takes half of the group of black and white bars to measure one character.
7.3.20 Ratio

The **Ratio** is the factor between the width of the narrow bar and the width of the wide bar in your barcode. For example, enter 3 if you want your wide bar to be three times as wide as your narrow bar.

7.3.21 Narrow Bar

This parameter determines the width of the narrowest bar of your barcode (and affects the width of your barcode proportionally). For GS1 barcodes, this affects the size (height and width) of your barcode proportionally.

7.3.22 Wide Bar

This parameter determines the width of the widest bar of your barcode.

7.3.23 Gap

Enter the width of the white space between the bars.

**Note:** The **Ratio** influences the **Gap** size: increasing the Ratio also increases the **Gap** size.

7.3.24 Vertical alignment

Dynamic Barcodes allows you to resize either the UPC-A or the GS1 Databar Expanded Stacked coupon barcode, so they are aligned vertically with each other. You can choose:

- **None** to keep the original size of both the UPC and the GS1 barcodes,

- **Resize UPC to GS1** to resize the UPC barcode so it has the same height as the GS1 barcode,

- **Resize GS1 to UPC** to resize the GS1 barcode so it has the same height as the UPC barcode.
7.3.25 Snap Bars to Output Resolution

Use this to adjust the barcode size parameters (Bar Width Reduction, Device Compensation and Magnification) so that the bars' width and height take up a complete number of pixels or dots.

Enable Snap Bars to Output Resolution and enter the resolution you will use to print your barcode in ppi.

7.3.26 Decimal Input

Use this parameter to change the type of data you can enter in the Code field.

- Disable it to enter the data to encode in binary format.
- Enable it to enter the data in decimal instead of binary format.

**Note:** When using binary format for the Laetus Pharma Code/CLF-8 barcode data, you need to use a special "Pharma" binary format.

To convert a decimal number into a Pharma binary number, do the following:

1. Add 1 to your decimal number.
2. Convert the result to a binary number using a regular binary conversion algorithm.
3. Remove the first digit (which is 1).

You now have your Pharma binary input for the Laetus Pharma Code/CLF-8 barcode.

For example, you want to encode the number 3.

1. 3+1=4
2. 4 in binary is 100.
3. Without the first digit, it's 00.

Enter 00 in the Code field of your Laetus Pharma Code/CLF-8 barcode.

7.3.27 Add Check Digit

Use this parameter to add a check digit to your barcode data.
Note: Code 39 doesn't usually contain a check digit but it can be required in some cases.

7.3.28 Symbol Type

Choose the number of cells to use for your barcode (in the format “horizontal cells x vertical cells”).

Note: If the number of cells you choose for your symbol is too small to encode the data you entered in Code, Dynamic Barcodes will display an error.

You can choose Best Fit to make Dynamic Barcodes automatically adapt the number of cells to the amount of data you entered in Code.

7.3.29 Cell Size

Enter the size you want to give to each cell of the symbol. This affects the size of the whole symbol.

The unit used is the one you chose as Illustrator’s General unit in the Units & Display Performance Preferences.

In the example below, the first symbol has a 1 mm cell size (cells sides are 1 mm), and the second one a 2 mm cell size.

7.3.30 Width / Total Height

The Width and Total Height parameters depend on the Cell Size and the number of cells used for the symbol (Symbol Type).
In the example below, a symbol of 10 x 10 cells where each cell is 3 mm gives a Width and Total Height of 30 x 30 mm.

### 7.3.31 Total Height

Enter the total height you want to give to your barcode. This is the combined height of the bars, the human readable characters and the box. If your barcode doesn’t contain human readable characters or a box, the **Total Height** is the same as the bars’ **Height**.

### 7.3.32 Smax / Smin

Use these parameters to define the width of the printability gauges (“H” marks) either side of your barcode. **Smax** defines the width of the left “H”, **Smin** defines the width of the right “H”. Enter 0 in both fields if you don’t want printability gauges.

In the example below, the top barcode has a value of 0 for both **Smax** and **Smin**, the middle one has a value of 4 and the bottom one has a value of 8 (the maximum).
7.3.33 Box

Use this parameter to create an opaque white box under your barcode.

Use the **Top**, **Bottom**, **Left** and **Right** fields to add a white margin around your barcode and make the box bigger.
By default, Dynamic Barcodes links the four margins' values so that when you change one of them, the other ones are updated automatically.

If you want to change them independently, click the link symbol to make it look detached.

For ITF, UCP and UPC-SCS bar codes, the box will be transparent, with bearer bars around it. The **Box Line Width** parameter defines the width of the bearer bars.

The option **Only Top and Bottom Bars** limits the bearer bars to only the top and bottom line.
8. Barcode Parameters from the Job Folder

Automation Engine stores information related to the printing jobs within the Job Folder. Each Job Folder can hold various job-related technical information, including barcode parameters.

The following barcode parameters can be set in Automation Engine Pilot:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Note</th>
<th>Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The type of barcode. You can't have two different barcodes of the same type in one job.</td>
<td></td>
</tr>
<tr>
<td>Sub Type</td>
<td>The size of the symbol for Datamatrix barcodes.</td>
<td>Symbol Type on page 91</td>
</tr>
<tr>
<td>Code</td>
<td>The encoded value including check digits.</td>
<td>Code on page 81</td>
</tr>
<tr>
<td>Composite Code</td>
<td>For barcodes with a Composite Component - mainly GS1 Databar codes</td>
<td>Composite Component on page 82</td>
</tr>
<tr>
<td>Output Resolution</td>
<td>Snap Bars to Output Resolution</td>
<td>Snap Bars to Output Resolution on page 90</td>
</tr>
<tr>
<td>Bar Width Reduction</td>
<td>Bar Width Reduction</td>
<td>Bar Width Reduction on page 85</td>
</tr>
<tr>
<td>Device Compensation</td>
<td>Device Compensation</td>
<td>Device Compensation on page 86</td>
</tr>
<tr>
<td>Narrow Bar</td>
<td>Main size parameter for Code128, Int2of5 and GS1 Databar barcodes</td>
<td>Narrow Bar on page 89</td>
</tr>
<tr>
<td>Magnification</td>
<td>Main proportional size parameter for EAN and UPC based barcodes</td>
<td>Magnification on page 86</td>
</tr>
<tr>
<td>Ratio</td>
<td>Used for Int2of5 barcodes</td>
<td>Ratio on page 89</td>
</tr>
</tbody>
</table>

**Important:** Automation Engine does not check the parameters. All listed parameters are available for all barcode types, even if they are not valid for the given barcode type. Make sure you're entering the valid inputs, including a correct Code with its check digit.

**Note:** It is not necessary to have the parameters already set on the Job Setup when creating barcodes: as soon as the Job Setup contains the settings for connected barcodes, these barcode parameters will be applied. This allows you to create templates or placeholders before the actual data (code for the barcode, etc) is available.

8.1 Connecting to a Job Folder

In order to take parameters from an Automation Engine Job Folder, you need to be connected to an Automation Engine, and open the file from the Automation Engine Job Folder. For easy locating the file on the server, you can use **File > Job Folder > Open from job folder**
For more information on how to connect to Automation Engine, and on opening from a Job Folder, we refer to the Esko DataExchange documentation. See [http://help.esko.com/products/Esko%20Data%20Exchange%20for%20Adobe%20Illustrator](http://help.esko.com/products/Esko%20Data%20Exchange%20for%20Adobe%20Illustrator)

### 8.2 Connect Dynamic Barcodes to Job Setup

To use the Barcode properties from the Job Folder, enable the **Get Properties from Job Setup**. When enabled, the icon on the right will indicate the status:

- Gray: the feature is disabled
- Green: the connection is established
- Red: the file is not in a Job Folder, or the connection is down.

### 8.3 Use Barcode parameters from Job Setup

To use the barcode parameters from Job Setup, select a barcode type from the Barcode Type list that is defined in the Job setup. You can recognize these barcode types by the green icon in front.
As soon as you select one of the barcode types defined in the Job Setup, all parameters that are defined in the job setup will be entered (and no longer be editable), indicated by the same green icon.

In the example above, only the **Code** is defined in the Job Setup. All other parameters can be entered freely.
8.4 Updating barcode parameters from Job Setup

If a barcode is connected to the Job Setup, any changes to the barcode parameters in the Job Setup, whether it is a changed parameter or a newly added parameter, will automatically and immediately be taken into account in Dynamic Barcodes.

When opening a file, all barcodes with the Get Properties from Job Setup option enabled will be updated automatically.

If a barcode type is removed from the Job Setup, the corresponding barcodes in the job will no longer be connected, so the Get Properties from Job Setup option is disabled.

A barcode will also be disconnected and the Get Properties from Job Setup option will be disabled in case the barcode parameters in the Job Setup are invalid for the given barcode type. You will need to change the parameters in the Job Setup. Note that after correcting the parameters, you need to manually reconnect the barcode by enabling Get Properties from Job Setup.